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3 Abstract 

 

Computational fluid dynamics (CFD) has great benefits in the world of fluid mechanics and 

turbomachinery. CFD helps visualize and predict fluid flow behaviors quickly and increases 

efficiency of turbomachine design. Users who are starting in CFD might not have sufficient 

online resources to start off their own design and simulation of a turbomachine. This 

technical project aims to help users by providing a step by step guide by using a centrifugal 

pump as an example. Geometry design was made using CFturbo while simulation was done 

in Star-CCM+ 
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5 It starts with CFD 

 

Computational Fluid Dynamics (CFD) started out from the development of Finite volume 

methods in the year 1980 at the Imperial College London. Since then, the knowledge and 

method has evolved into a branch of fluid mechanics that solves and analyzes fluid flow and 

heat transfer patterns and behavior using applied mathematics and physics inside a 

computational software to enable quick and comprehensive analysis and making better fluid 

and heat flow predictions. Because of its considerable advantages, the technology has and is 

rapidly growing and is being used in many engineering branches for example hydraulics, 

aeronautics and even medicine technology.  

CFD can be commonly found implemented in the design phase in the industry. The detailed 

results from CFD simulations will be followed by experimental validation in small scale 

models where the design can be reiterated before proceeding to full scale testing. CFD allows 

rapid changing of design and design parameters to suit the needs of users which before this 

can only be done interminably by building many components and testing it with a rig. 

Application of CFD changes the game by allowing design and optimization of products 

without needing to have physical models hence saving time, money, and other resources.  

CFD uses numerical analysis and structural data to analyze and solve problems that involve 

fluid flow. Since the behavior of fluid flow is complex in real life, mathematical equations 

and models have been developed throughout the years for CFD softwares to perform the best 

flow prediction that is closest to real life simulations. With the development of consumer 

electronics, good computers are getting cheap and cheap computers are getting good to the 

point that the technology is now accessible for everyday consumers in terms of 

computational power needed to run a fairly complex flow simulation.  

Engineers and engineering students who are well educated in fluid mechanics in particular 

turbomachinery might still find it hard though to start their first simulation as the simulation 

software features many different settings and each brand of software shows those settings 

very differently. With that in mind, this practical project aims to guide new users in starting 

their first turbomachine simulation which is a centrifugal pump using two major established 

softwares which are CFturbo [1] and Star-CCM+ [2]. CFturbo has its strength in 

turbomachinery design with high-level of operating comfort and value for money while Star-

CCM+ is an all-in-one simulation software solution that delivers accurate results as well as 

being efficient as the multidisciplinary software works in a single user interface. 

 

 



P a g e  | 8 

 

6 Geometry generation using CFturbo 

 

For this technical project, CFturbo version 10.2 was used. Version 10.2 or higher is highly 

recommended as earlier version of CFturbo uses point based CFD ready export file format 

which is different to the step file format used in Version 10.2. Step format has significant 

benefits over the older point based format for example better control over quality of mesh. 

The different formats also have different simulation setup procedures. The older format is 

setup using ‘Turbo wizard’ in Star-CCM+ which will not be covered in this technical project. 

 

6.1 Opening file 

 

Instead of designing a turbomachine from the very beginning, several examples of pumps, 

ventilators, compressors, and turbines are already premade and available for users to export 

or modify. These files are available locally in the installation directory of the program in the 

local drive. By starting CFturbo 10.2, the files can also be accessed in the default examples 

folder on the main menu.  

This technical project will go through an example centrifugal pump called ‘RP nq20 volute 

(generic)’ which is available under Default examples > Pump > Radial, Mixed flow. The file 

‘RP nq20 volute (generic)’ consists of a radial flow impeller and a volute casing without 

vane diffusers or guide vanes. The following shows the meridional cross section of the 

components on the main window after the file is opened: 

 

 

Figure 1: A centrifugal pump [4] 
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6.2 Visualizing the shape and motion of the pump 

 

By default, the cross section of the pump is shown. For new users who might not understand 

the actual shape of the pump, a 3D model is also available and can be viewed by clicking 

‘3D model’. The light blue coloured region is the fluid region which is located between the 

hub and shroud of the actual impeller. To view the impeller blade, ‘Radial Impeller’ must be 

highlighted in the ‘Model state tree’ The transparency can then be set at a lower level for 

example 10%.  

Figure 2: CFturbo main window 

Figure 3: 3D model of a centrifugal pump 
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This particular impeller has 6 blades which are curved in a logarithmic pattern. The golden 

region is a periodic segment of the Impeller. In CFD, it is a common practice that periodic 

segments are simulated instead of the whole geometry of a rotating component to cut down 

on computational time and power. But this method of simulation will be a bit tricky and the 

periodic geometry shape will not be easily understandable for new users, so the full geometry 

of the impeller will later be exported for this example.  

Under the ‘3D Model’ tab is a checkbox that shows the impeller rotation. When this box is 

checked, the impeller will start to rotate. By the movement of the rotation, it is 

understandable the vanes are backward curved which is common for a centrifugal pump. 

This curved shape allows the pump to have a self-stabilizing characteristic. When a pump is 

designed, it is designed with a specific rate of volume of flow which is called flow rate or 

discharge. When an impeller has backward curved veins, the power required by the motor to 

drive the pump drops down as opposed to going up. This is safer as the pump can then handle 

a wider range of flow rates.  

It is also noted that the axis of rotation is the negative Z axis. Impellers generated by Cfturbo 

rotates in the -Z axis by default. Later on as the exported geometry has been imported in 

Star-CCM+, the geometry will also be positioned with the same coordinate system as in 

CFturbo. This is important to know as the axis of rotation must be defined manually in Star 

CCM+ during setup.  

On the left side of the main window is a blue impeller cross section icon. Clicking on this 

icon will show the impeller setup section. There is also a tab at the topwhich can be clicked 

that has the same function. Under the Impeller tab is where all the settings for modifying the 

impeller are available.  

Figure 4: power requirement of different vein curve shapes [7] 
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6.3 Changing the impeller dimensions 

6.3.1 Main dimensions 

The ‘Main dimensions’ window contains the hub diameter 𝑑𝐻, suction diameter 𝑑𝑆, 

Impeller diameter 𝑑2, and outlet width 𝑏2 settings where it can be changed. The Cordier 

diagram is also available in this window. Clicking on the Cordier tab shows where this 

impeller lies in the Cordier diagram. The velocity triangle of the impeller can be viewed in 

the velocity tab just next to the Cordier tab. Both the cordier diagram and velocity triangle 

are only empirical estimations by CFTurbo and does not represent the real simulation. It is 

useful as a general overview of the impeller in its design phase. The settings made in this 

window were then saved by clicking OK. 

 

Figure 6: Cordier diagram Figure 7: Velocity triangle 

Figure 5: Impeller design: Main dimensions window 
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6.3.2 Blade properties 

Blade properties icon should be selected next. It is in this window that the inlet vane angle  

𝛽𝐵1 and outlet vane angle 𝛽𝐵2 as well as number of vanes can be changed (Note the value 

of outlet vane angle). Going back to the ‘Main Dimensions’ window, the main dimensions 

can be changed to the values: 

Hub diameter 𝑑𝐻 =  30𝑚𝑚,  

Suction diameter 𝑑𝑆 =  90𝑚𝑚,  

Impeller diameter 𝑑2 =  230 𝑚𝑚,  

Outlet width 𝑏2 =  14𝑚𝑚.  

Going back to ‘Blade Properties’, it is seen that the vane angle at outlet 𝛽𝐵2 had changed to 

14° whereas it was at a value of 20°. This is because the angles are set to automatic 

calculation by default. When it is at automatic, changing the main dimensions will affect the 

blade angles. The automatic setting follows the design relevant efficiencies of hydraulic 

efficiency ηh, volumetric efficiency ηv, and additional hydraulic efficiency ηh+.  

To manually define the blade angles, disable automatic. Then set the blade angles to: 

Inlet blade angle βB1 = 12° 

Outlet blade angle βB2 = 14°. 

Set the number of vanes to: 

Number of blades = 5 

 

Figure 8: Blade properties window 
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6.3.3 Blade mean lines 

Next parameter to change is the Wrap angle 𝜑. Wrap angle is the angle between the leading 

edge and trailing edge of the vane from the axis of rotation.  

The setting of wrap angle is located under ‘Blade mean lines’. Since this is a radial flow 

impeller with fully radial vanes, the wrap angle is constant throughout the vane length. 

Change the wrap angle to: 

 Wrap angle (common/average) = 110° 

 

6.3.4 Global Setup 

When designing pumps from scratch, the first thing the user was asked by CFturbo are the 

design points. The design point contains: 

Flow rate 𝑄 

Head 𝐻 

Revolutions 𝑛  

After these values have been given, the software will automatically generate a suitable type 

of machine wether it is radial, mixed flow, or axial flow machine based on the specific speed.  

Changing the design point for an already generated geometry until the machine type changes 

however will cause an error message to appear. So, changing a machine type mid-design is 

to be avoided.  

To test this out, the ‘Project’ tab at the top left of the main window shall be selected. The 

global setup can then be selected. The current pump used, ‘RP nq20 volute (generic)’ is a 

centrifugal pump which has radial through flow. Radial pumps are used for high pressure 

output and lower flow rate. Note that lowering the Head H in the design point in global setup 

from 50m to 40m will increase the specific speed of the pump and slowly pushing the design 

into mixed flow territory. Having the fluid head to 40m and the flow rate Q at 600 m3/h will 

change the pump to a mixed-flow machine. Since the pump is intended to be kept as a radial 

machine, the settings were left at default by having Head 𝐻 at 50𝑚 and Flow rate 𝑄 at 

60𝑚3/ℎ. The number of revolutions 𝑛 of 2900 𝑟𝑝𝑚 is important to remember as this value 

Figure 9: Wrap angle [8] 
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is needed later when setting up simulation in Star-CCM+. The additional hydraulic 

efficiency ηh+ mentioned before in Chapter 6.3.2 can be changed under ‘optional’. 

Another important setting write down is the fluid properties. For this pump, the fluid that 

will be driven is water at 20°C. To view the details of the fluid medium, the 𝜚 symbol was 

selected. The default value of density of water 𝜚 at 20°C of 998.2 kg/m3 and kinematic 

viscosity 𝑣 of 1x10-6 m2/s should be written down. This is because Star-CCM+ has a different 

default value of density and should be changed to get a better comparison of the results from 

Star-CCM+ to CFturbo’s prediction via ‘Performance prediction’. Simulation in Star-CCM+ 

also uses the value of dynamic viscosity µ which can be derived from density and kinematic 

viscosity. The default settings of the fluid medium were left unchanged and the global setup 

was closed. 

6.4 Performance prediction 

The project tab is again selected and performance prediction was opened. Here, the 

performance prediction of the impeller (blue region) and the volute casing (green region) are 

shown. The black region represents the slip. The red curve represents the flow characteristics 

at 2900 rpm.  

To add more curves to represent different revolutions of impeller, the ‘Additional curves’ 

tab under settings can be selected. The ‘+’ sign can be clicked to to add in more values. Add 

four more curves with the the revolutions: 

  𝑛 =  3500;  3300;  3100;  2700;  2500 𝑟𝑝𝑚 

Figure 10: Global setup window 
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The curves will only visible by activating the check boxes next to the values. The 

performance prediction diagram of impeller and volute casing is as shown: 

Changes should be saved afterwards by clicking OK.  

The simulation that will be done on Star-CCM+ is later is of the impeller only, without the 

volute casing. To have a clear overview of the performance prediction of only the impeller, 

the volute casing component must be removed. The green square icon with the picture of 

volute casing should be selected with a right click and ‘delete component’. The new 

performance prediction diagram is as shown: 

Figure 11: Performance prediction (Impeller with volute casing) 

Figure 12: Performance prediction (Impeller without casing) 
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The tip of the arrow points to the design point of the impeller with casing which before the 

volute casing was deleted. The red final characteristic curve runs through this point when 

the casing was not yet deleted because the design point in global setup was made to include 

the casing. Note that the curves that represent each revolution have shifted upwards and has 

a gentler curvature.  

 

6.5 Exporting to Star-CCM+ 

The modifications on the geometry are now complete. The geometry should be prepared for 

CFD simulation. This means that the rotor-stator-interface must be defined. Under the 

‘Impeller’ tab, CFD Setup should be selected and ‘Defining Rotor-Stator-Interface (RSI)’ 

should be activated.  

The last step needed to be done is the model finishing. The model finishing process is to 

establish the connection between blade and hub/shroud. By default, every geometry changes 

will not be updated into the final file. Only after every modification has been made, and 

‘Model finishing’ is selected, will the design changes be made. This eliminates loading times 

between design changes which is undesired. To start model finishing, model finishing icon 

should be selected. The default setting is solid trimming which is the most accurate but time-

consuming with a fillet radius of 1.5mm at both hub and shroud. The default settings are 

acceptable and can be selected by clicking OK.  

The Modelling phase is now finished and ready to be exported as a Step format file into Star-

CCM+.  The green icon titled export which is under the project tab can be selected. In the 

export window, the ‘Interfaces’ tree is seen on the left. Star-CCM+ should be chosen   

If all the steps were done correctly, no error messages should appear and a green tick will 

appear under the radial impeller icon. The radial impeller icon should be ticked and a suitable 

export destination on the pc is selected. A suitable file name should be given as a base name 

for the file.  

If more than one components were exported, it will have the format of <Base file 

name_Co#.stp>  The # is an integer with lowest integer being the component closest to fluid 

inlet and the biggest integer for component furthest from fluid inlet. 

Under Parameters, ‘set parameters’ can be clicked and ‘Full geometry (360°)’ can be chosen. 

The export is finalized with an OK and the export window can be closed right after. Lastly, 

the project should be saved before closing the main window. 
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7 Simulating using Star-CCM+ 

Simulation with Star-CCM+ is rather intuitive as the main settings were laid out in folders 

rather than drop down menus. With an available geometry, preprocessing can be started. 

Star-CCM+ icon was clicked to start the program. A new simulation was created by selecting 

File > New Simulation. It is assumed that the user has an access to the program with a Power-

On-Demand license. Power-On-Demand license is selected and the key for this which is 

available on the users Steve Portal account (online) was typed in. The OK key was selected 

and the settings tree should appear after a few seconds. It is highly recommended that a stable 

internet connection is available throughout the simulation process as the program will 

constantly check the validity and availability of the license. Simulation will stop running 

when user is disconnected from the internet. 

 

7.1 Preprocessing: Importing files 

Firstly, the prepared geometry that has been exported from CFturbo should be imported. This 

is done by clicking the triangle icon on the toolbar called ‘import surface mesh’. The step 

file from the export folder specified earlier is then opened.  

In the import surface dialogue, the default settings were accepted by clicking OK. After this 

is done, the imported parts can be viewed under the Parts folder. A new Geometry scene will 

also be made automatically. Whenever the program is closed and then re-opened, the scenes 

whether it is a geometry scene, vector scene, mesh scene or any type of scenes will not 

automatically open. It is still available under the scenes folder and be re-opened by double 

clicking on the required scene. 

Figure 13: Imported radial impeller 
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7.2 Setting up regions 

Regions in Star-CCM+ are for fluid regions. Since CFturbo export file has already prepared 

the model as a negative form of the pump (only fluid regions without physical components), 

the Surface wrapping and surface repair processes can be skipped.   

The parts in the Parts folder in Star-CCM+ are only geometry surfaces. To define it as a 

region, right click on Radial Impeller and select ‘Assign parts to regions’.  

Next, choose ‘Create a region for each part’ and choose ‘create a Boundary for each part 

surface’. Leave the other settings at their default. Now click Apply and then close. A new 

fluid region has been added under Regions folder in the settings tree.  

 

7.3 Preprocessing: Setting up mesh 

To start meshing, right click on Continua and select New Mesh Continuum. Right click on 

Continua > Mesh 1, and select Meshing models. Choose Surface remesher as surface mesh 

and polyhedral mesher as volume mesh. This process changes the surface and volume of the 

geometry to mesh form which has nodes for which the calculations during simulation will 

be made. Polyhedral cells have many advantages most notably is that there are many 

neighboring cells typically in order of 10. This allows better approximation of gradients 

compared to the standard tetrahedral cells when using linear shape functions and information 

from only neighboring cells. [3] 

After choosing polyhedral mesher as your volume mesh, other optional models will be made 

available. Prism layer Mesher should be chosen as an optional model. Prism layer is 

important as it captures and solves boundary layer effects. Prism layer also allow high aspect-

ratio cells without excessive stream-wise resolution. Where the solution gradient near the 

wall is very high, it is also more cost effective (computational cost) to add up prism layers 

Figure 14:Assigning parts to regions 
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near the wall giving good convergence and fairly accurate results. After all three models are 

selected, the Model selection can be closed. [4] 

 

 

Now it is time to refine the mesh. Under reference values, the following were selected: 

Base Size: 1.3𝑚𝑚 ⋯ 0.3 𝑚𝑚 

Number of Prism Layers: 10 

Prism Layer Stretching: 1.2 (20%) 

To generate the mesh, the first step is to click the ‘generate surface mesh’ button on the 

toolbar. After it has finished, click on the ‘generate volume mesh’ button right next to it. It 

takes a while to generate the surface mesh and volume mesh so make sure to not disturb the 

program when it is running as the program might crash. The meshing process will not run 

unless regions have been defined. 

Right click on the Scenes folder and select new scene > Mesh scene. Right click on the 

display and select apply representation > Volume mesh. With this, the mesh quality can be 

inspected visually. To determine the number of cells, click on Mesh > diagnostics. Choose 

compact report and find the number of cells. 

 

Figure 15: Mesh model selection 
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Figure 18: Volume mesh with polyhedral mesher and prism layer mesher 

Figure 16: Remeshed surface with surface remesher 

Figure 17: Initial surface 
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7.4 Physics models 

Choosing proper physics models are important as it effects the simulation time and accuracy 

of the results. Some physics models are more important to be chosen correctly to get 

simulation results that are closest to real life. For example, the viscous regime in centrifugal 

pump is turbulent. Choosing inviscid or laminar flow will give results that vary very 

differently from experimental tests.  

To start the physics model selection, Continua must be right clicked and New > Physics 

continuum selected. A Physics continuum called ‘Physics 1’ will then be available under 

Continua. Right clicking on Physics 1 and choosing select models will open the Physics 1 

model selection dialogue. The following settings should be chosen: 

 

Space: Three Dimensional 

Time: Steady 

Material: Liquid 

Flow: Segregated Flow 

Gradient Metrics: Gradients (will be automatically selected) 

Equation of State: Constant density 

Viscous Regime: Turbulent 

Turbulence: Reynolds-Averaged Navier-Stokes (automatically selected) 

Reynolds-Averaged Turbulence: k-Epsilon Turbulence 

k-Epsilon Turbulence Models: Realizable K-Epsilon Two-Layer (automatically selected) 

Wall Distance: Exact Wall Distance (automatically selected) 

k-Epsilon Two Layer All y+ Wall Treatment: Two-Layer All y+ Wall Treatment 

 

The decision made to use k-Epsilon turbulence model is for its robustness. Despite of its 

known limitations as a turbulence model, it is still widely used and easy to implement. It is 

suitable for initial iterations, initial and screenings of alternative designs and parametric 

studies. The turbulence model uses less computational resources and is only valid for fully 

turbulent flows. [5] 
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Figure 19: Physics model selection 

After done selecting the models, the dialogue should be closed. 

The material properties of the liquid needs to be changed. In Cfturbo, the default liquid used 

in pump simulation is water at 20°𝐶 with density of 998.2 𝑘𝑔/𝑚3 and kinematic viscosity 

of 1 ∙ 10−6 𝑚2/𝑠. The value of ‘dynamic viscosity’ can be derived with the following 

formula: 

𝜇 = 𝑣 ∙ 𝜌 

where  

µ  = absolute or dynamic viscosity [𝑁𝑠/𝑚2] 

υ  = kinematic viscosity [𝑚2/𝑠] 

ρ  = density [𝑘𝑔/𝑚3] 

 

As the density of fluid is constant, the dynamic viscosity will also be a constant with constant 

kinematic viscosity. The values for density and dynamic viscosity can be changed in Physics 

1 > models > liquid > H2O > Material properties.  
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7.5 Setting up motion 

The Tools folder should be expanded. ‘Motions’ folder can be right clicked and a ’new 

Rotation’ must be set. The ‘Rotation rate’ should then be set to 2900 rpm and ‘Axis 

Direction’ changed to [0.0, 0.0, -1.0] as the impeller rotates in -Z axis. The other settings 

should then be left unchanged. As a result, a folder called ‘Reference Frame for Rotation’ 

will be made under Tools > Reference frames. 

 

The rotation has now been defined but the region that is rotating has not yet been set. Under 

Regions > Radial Impeller > Physics values > Motion Specification, the reference frame 

must now be changed from ‘Lab Reference frame’ to ‘Reference Frame for Rotation’. If one 

should also import a volute casing, the motion specification should not be changed as the 

default is stationary motion in Lab reference frame. The default motion is also valid for other 

stator components such as stationary inlet guide vanes and stationary vane diffusers.  

Figure 20: Rotation properties 

Figure 21: Motion specification properties 
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7.5.1 Inflow and Outflow boundary of Impeller region 

For an energy giving turbomachine, it is suitable for the Boundary region of Inflow of the 

Impeller to be set to either ‘Stagnation Inlet’ or ‘Mass flow Inlet’. For this pump, the flow 

rate was defined in the global setup of Cfturbo. With a constant density, we can derive the 

mass flow rate from our predefined flow rate with: 

�̇� =
𝑄 ∙ 𝜌

3600
 

where 

ṁ = mass flow rate in [𝑘𝑔/𝑠]  

Q = Volume flow in [𝑚3/ℎ] 

ρ = density in [𝑘𝑔/𝑚3]  

The value of mass flow rate is needed because in star CCM+ boundaries can be defined as 

mass flow inlet but not flow rate. To change the inflow boundary condition, the Inflow 

boundary should first be highlighted. In the properties table, the type of boundary should be 

changed from wall to mass flow inlet. Expand inflow and go to physics values > mass flow 

rate. In the properties table, set mass flow rate to 16.637 𝑘𝑔/𝑠. 

The Outflow boundary can be easily changed by highlighting ‘Outflow’ under Regions > 

Radial Impeller > Boundaries and changing the boundary type available in the properties 

table from wall to ‘pressure outlet’. 

 

7.5.2 Periodic Interface 

For advanced users who are using periodic impeller geometry instead of the whole 360° 

geometry of impeller, ‘Periodic A’ and ‘Periodic B’ boundaries will be available under 

Regions > Radial Impeller segment. These surfaces should be connected via Periodic 

boundary.  

This is done by highlighting both Periodic A and Periodic B by holding the Ctrl key and 

selecting both boundaries. Then right clicking on either one and select ‘create Interface’. 

This adds a new Interface called Interface 1 in the interfaces folder. Highlight Interface 1 

and select ‘Periodic’ as the topology. Now highlight periodic Transformation under Interface 

1 and in the properties table, set periodicity to ‘Rotational’. The program will automatically 

calculate the number of periods based on the angle of segment and the axis of rotation. The 

program will also check whether the surfaces do match for a periodic function*.  

*After periodic interface has been setup, the geometry needs to be remeshed. Steps on how 

to remesh a geometry can be found in Chapter 7.3. 
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*Mass flow rate calculated in Chapter 7.5.1 must also be divided by number of 

periods.:Since number of periods will be the same as number of blades, the following 

formula to calculate the mass flow rate at inlet per period �̇�𝑝𝑒𝑟𝑖𝑜𝑑𝑖𝑐 is: 

�̇�𝑝𝑒𝑟𝑖𝑜𝑑𝑖𝑐 = �̇� 𝑍⁄  

with  Z = Number of blades 

 

7.6 Report setup 

The simulation setup is almost at the end.  

To create a report, the Reports folder must be right clicked and new report > Mass flow 

Averaged selected. A new report called Mass Flow Averaged 1 will be generated. The report 

shall be renamed to ‘Mass Flow Averaged Radial Velocity’. The report should be edited by 

right clicking on it and choosing edit. Scalar field function should be changed to Radial 

Velocity and Outflow boundary region should be chosen under Parts. The report editor can 

then be closed. 

This report will now be duplicated and the scalar field changed to relative Tangential velocity 

and the file renamed to ‘Mass Flow Averaged Relative Tangential Velocity’. 

A third report is needed for the total pressure difference between the Inlet and the Outlet. 

‘Pressure Drop’ report should first be created and Outflow boundary selected as the high 

pressure and Inflow boundary as the low pressure. The report can be renamed to Pressure 

difference.  

The last report needed is to determine the time taken for each iteration. This report can be 

made by creating a new solver Iteration CPU Time report. 

 

7.7 Stopping criteria 

Stopping criteria folder should be opened and Maximum steps should be reduced from 1000 

iterations to 600 iterations.  

 

7.8 Postprocessing: Vector setup 

Vector scenes are used to visualize the flow of the fluid in the region. Relative velocity in a 

centrifugal pump is the absolute velocity of fluid minus the peripheral velocity. Setting 

relative velocity as the vector field in a rotating reference frame also allows new users to 

better understand the flow inside a centrifugal pump. A new vector scene can be created by 

right clicking Scenes and choosing create a new scene > vector scene. Under Vector scene 1 

> Displayers > Vector 1 > Vector Field, ‘Relative Velocity’ should be chosen as function in 

the properties window.  
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Next step is to generate a plane section that will contain vectors in the meridian view. The 

first step is changing the view of the Vector scene. 

This is done by selecting the camera icon on the toolbar and select views > -X > Up -Z. Now 

click on the camera icon again and change the projection mode to ‘Parallel’. Hold the right 

mouse button to shift the position of the geometry to the center of the scene and use the scroll 

wheel on the mouse to zoom in. Now on the toolbar, there is a yellow icon with letters ‘fx’ 

called create plane section. Click on this icon to start creating a plane section that lies in 

between the hub and shroud. Once the button is clicked, click on the first point on the outside 

left of the impeller. Drag the mouse to the right side of the impeller horizontally and click 

the outside of the impeller.  

 

Once that is done, a dialogue will appear for displayer selection. Select No displayer and 

click OK. This avoids the plane section to be bounded to any particular scenes. This means 

that the plane section can be used for different scenes as well. 

Under Vector scene 1 > Displayers > Vector 1 > Parts > derived parts, the Plane section 

and the entire Regions folder apart from Hub and Shroud should be chosen. Click Ok to 

accept changes. Now right click anywhere on the displayer outside of the impeller geometry 

and select Apply Representation > Volume Mesh. The vector on the plane section will only 

appear on this representation.  

The setup is finally finished. The simulation can now be saved with an appropriate name 

before clicking on the run icon to start the simulation. The Residual plot will automatically 

appear and the simulation will run until 600 iterations. To stop the operation anytime during 

simulation, the red square icon in the toolbar can be selected to stop the iteration process. 

The run icon can be clicked afterwards to continue iterating. After the simulation is complete, 

each of the report can be clicked to view the results. The vector scene can also be viewed 

and manipulated during or after simulation. 

 

Figure 22: Side view of radial impeller outline 



P a g e  | 27 

 

8 Summary 

The geometry setup shown per CFturbo is valid in general pump simulation cases. CFturbo 

is also capable in more detailed geometry variations should it be needed. As for the 

simulation setup shown per Star CCM+, they are specific to determining the slip angle and 

hydraulic characteristics of a pump. For other simulation purposes, the simulation setup can 

be varied to suit. Both CFturbo and Star CCM+ are very capable in geometry generation and 

simulation of other types of turbomachines respectively as well.  
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